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This manual was written for use with the Westhold Race Manager for Windows software version 1.39.1.53.  This 
manual and the Westhold Race Manger software described in it are copyrighted, with all rights reserved. This manual 
and the Westhold Race Manager software may not be copied, except as otherwise provided in your software license 
or as expressly permitted in writing by Westhold Corporation (WESTHOLD). 
  
Copyright © 2002-2024 by WESTHOLD. All rights reserved. 
 
Microsoft and Windows are either registered trademarks or trademarks of Microsoft Incorporated in the United States 
and/or other countries. 
 
 
Use of the Westhold Race Manager software and other software and fonts accompanying your license (the 
"Software"), and its documentation are governed by the terms set forth in your license. Such use is at your sole risk. 
The Software and its documentation (including this manual), and WESTHOLD software maintenance and extended 
maintenance, if applicable, are provided "AS IS" and without warranty of any kind and WESTHOLD AND ITS 
LICENSORS (HEREINAFTER COLLECTIVELY REFERRED TO AS "WESTHOLD") EXPRESSLY DISCLAIM 
ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND AGAINST 
INFRINGEMENT.  WESTHOLD DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL 
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. 
FURTHERMORE, WESTHOLD DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING 
THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR ITS DOCUMENTATION IN TERMS OF 
THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY WESTHOLD OR A WESTHOLD AUTHORIZED 
REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO 
THE ABOVE EXCLUSION MAY NOT APPLY.  UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, 
SHALL WESTHOLD, ITS LICENSORS OR THEIR DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE 
LIABLE FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES 
FOR LOSS OF BUSINESS, LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR 
ITS DOCUMENTATION, EVEN IF WESTHOLD OR A WESTHOLD AUTHORIZED REPRESENTATIVE HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY. 
 
In no event shall WESTHOLD total liability to you for all damages, losses, and causes of action (whether in contract, 
tort, including negligence, or otherwise) exceed the amount paid for the Software and its documentation. 
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User Manual  
 

1. Introduction 
 

1.1 General Information 
 

The Westhold Race Manager Software is used to control the Westhold Race Management System 
electronic race timing system.     

1.2 Requirements 
 

In order to install and use Westhold Race Manager, you must have the following: 

IBM PC or compatible with 256M Bytes of free memory or more and at least 50M Bytes of free 
hard drive space on your computer.   

Microsoft Windows 95/98/ME/XP, Windows NT 4.0, Windows 2000, Windows XP Pro, Windows 
XP Home, Windows Vista, Windows 7, Windows 8/8.1 and Windows 10 It is recommended that 
you have the latest service pack for each operating system. 

1.3 Installation 
 

Run the RaceMgr_139153 setup program.  This will start the installation program.  Follow the instructions 
for installation.  A Windows Desktop icon will be created. The default installation folder is 
C:\RaceManager. 

1.4 Quick Start 
 

Before starting the software, verify the hardware has been configured properly.  Be sure all the cables are 
connected and secure.  Make sure the PC is connected to the IDU or the IDEC decoder via an RS232 serial 
cable or CAT5 network cable. 

Power on the IDU or IDEC.  A green power indicator on the front of the unit will light up. 

Start the Race Manager program by double-clicking on the Desktop icon or selecting the program from the 
<START>/<PROGRAMS>/RaceManager location. 

When the software is started for the first time some warning messages may appear regarding the setup of 
com ports and the RMS.   This is normal.  Click on the ‘OK’ buttons for the warning messages. 

 

 



 

  Page 7 
 

 

2. Overall Description 
 

The program is segmented into several logical sections.  These are indicated by tabs at the bottom of the 
program window.  The three sections are Setup, Assign and Timing.  The tabs are set up from left to right 
to indicate the typical flow of operation by the user. 

 

2.1 Setup Tab 
 

The setup page includes several parameters used to set up the software to communicate with the RMS and 
scoreboard.   

 

2.1.1 System Status/Control  
 

The System Status/Control box is in the upper left corner.  It allows you to select the type of system you are 
using and indicates the status of the system.  The Status box will initialize with the words ‘Not Found’ and 
the background will be red.  If the RMS components are found the box will display the appropriate data and 
the background color will be green.  Typically, the first time the system is started the software will not 
discover the components.  Some setup must first occur. Follow the procedure below to initialize the system. 

1. Select the Decoder type – IDU or IDEC 

 

 

 

 

 

 

OR     
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IDEC            IDU 

 

2. If you are using an IDEC select whether you want to use TCP/IP (network) or not.  If you are not using 
IDEC skip to step 3.  Depending on whether the TCP/IP checkbox is checked you will see the button 
below change to either Set Comm Port or Set TCP/IP. 

Note: Do not select MAC Enabled unless your IDEC supports this method.  MAC 
enabled units are used for multi-IDEC setups. 

3. Click on Set Comm Port in the System Status/Control box.  A list box will appear with the operational 
com ports.  Or in TCP/IP mode click the Auto Discover button to attempt to auto discover the IDEC.  Or 
you may manually enter the IP address by clicking the Set TCP/IP button and a window will pop up to 
allow the entry of the IP address and port number.  The port number for the IDEC is 10001.  The default 
IDEC address is 192.168.1.49.   

NOTE: If your router assigns addresses to your computer, you will not be able to connect to the IDEC 
unless the first 3 numbers of your computer address matches the first 3 numbers of the IDEC address (e.g. 
192.168.1.xxx). Auto Discover will not work.  You must either change the router such that it assigns 
address in the same domain 192.168.1.XXX or you must change the IDEC address to match the first 3 
addresses your router assigns.   

NOTE: It is also possible to connect your computer directly to the IDEC.  However, you will have to assign 
your PC an address in the same domain (e.g. 192.168.1.5) as the IDEC.  Normally this will have to be done 
by giving your computer a static IPV4 address.   

4. Click the ‘OK’ button.  Race Manager will attempt to discover and communicate to the RMS components.  
When it successfully locates the components, the indicators will light green and display the appropriate data.  
For IDU systems the windows will display the IDU serial number as well as the decoder serial numbers.  In 
IDEC mode the current time and day will appear.  The other 2 boxes will show firmware version numbers. 
  

2.1.1.1 Demo Mode On 
 

When this checkbox is checked the software is placed in a demonstration mode.  This is useful for learning 
about the system without having all the hardware equipment connected.  In this mode it is also possible to 
output scoreboard data and test the scoreboard feed. 

In Demo mode the software will output transponder numbers from 1001 to 1010 in random order when the 
race view is active. The race information will continue until the Finish button is pressed.  If the qualify view 
is active the numbers 1001-1005 will be shown with each of the transponders’ numbers making 4 crossings.  
Note that the lap times are not realistic numbers.  They are simply used to demonstrate some of the software 
features and exercise the scoreboard output. 
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Note: System Status/Control com ports will turn yellow with DEMO MODE inside of them.  It is 
recommended that the Min Lap Time is set to 0 sec, Min Hits is set to 0 hits and Min Power is set to 0 dB 
in demo mode. 

  

2.1.2 Set Min Lap Time 
 

This is used to set the minimum acceptable lap time.  It is used to prevent unwanted detections such as when 
a car spins out over the antenna and crosses it multiple times or when a transponder is accidentally brought 
near the antenna or some other point where it can be detected by the Decoder.    

To set the minimum lap time click on the Set Min Lap Time button and enter the number of seconds in the 
window that pops up. Click OK when finished or Cancel to abort the operation. 

Note: The crossing on the crossing screen will be Gray in color. 

 
 

2.1.3 Set Min Hits (Squelch) 
 

This is used to set the minimum acceptable hits.  It is used to prevent unwanted detections from stray 
transponders such as when someone walks near the antenna loop.  A hit is a transmission from a transponder 
with the transponder's identification code.  Each transponder transmits a certain number of times per second.  
When the transponder goes by the detection loop the timing system will receive transmissions.  The faster 
the transponder goes by, the fewer the hits.   
 
Typically, when a transponder passes near the loop, but not directly over the loop, the number of hits 
received is very low.  If the min hits setting is set to some minimum threshold, transponders detections that 
do not meet this minimum are discarded and not shown on the Timing screen.  The default number is zero 
(0).  In this case, the minimum hit threshold is ignored. 
 

 
 
 

Note: The crossings which do not meet this minimum will be discarded and not show up on the screen.  Be 
very careful when using this.   
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2.1.4 Set Min Power 
 

This is used to set the minimum acceptable detection power level.  It is used to prevent unwanted detections 
from stray transponders on the edge of the Decoder detection range. 

To set the minimum power click on the Set Min Power button and enter the number of dB in the window 
that pops up.  Click OK when finished or Cancel to abort the operation.  A typical threshold number is 
about 19-20 dB.  Some experimentation may be necessary to pick an appropriate value. 

Note: Leave the setting at 0 or blank if you do not want to use the filter. 

 

2.1.5 Set Backup Transponder Interval 
 

This is only used if you are using two transponders per racer.  To use this feature a backup transponder 
number must be assigned on the Assign page (Section 2.2).  This setting is the interval in which both 
transponders must be detected to be considered a single crossing.   
 

 
 
For instance, transponder number 1001 is the primary and 1002 is the backup used for one racer.  Say the 
interval is set to 1 second.  If 1001 is detected first and 1002 is detected within 1 second of 1001, 1002 will 
be determined to be a backup transponder.  This is also true if 1002 is detected first and 1001 is detected 
within 1 second.  What will appear on the screen is the primary transponder number assigned.  In this case 
1001 will always appear whether or not 1002 was detected first.   
 

2.1.6 Caution Handling 
 

This group of controls is used to set parameters for how caution conditions will be handled. 
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2.1.6.1 Finish Lap on Caution (Only for Scored Caution) 
 

This feature is used to handle split scoring situations.  If the box is checked, the competitors will be scored 
only once when they cross the start/finish after the Caution-Score button on the timing screen is pressed.  If 
not checked, all scored caution laps will be counted when computing the position of the competitors. 

This is also used in situations when competitors race to the yellow. 

Note:  Read tutorial section for information on split scoring. 

2.1.6.2 Freeze Place Display on Race to Yellow 
 

If this box is checked in when the Finish Lap on Caution box (Only for Scored Cautions) is checked the 
Place screen on the Timing page will freeze the running order in place.  Otherwise, it will update the screen 
as racers pass the start/finish line. 
 

2.1.6.3 Auto Delete Partial Laps on Caution 
 

If this box is checked partial laps will be marked as caution when the non-scoring Caution button on the 
timing screen is pressed.  For instance, if there are 10 competitors on the track and two vehicles cross the 
start/finish line before the caution flag is thrown, the crossings by the first two vehicles will be automatically 
marked as caution.  

2.1.6.4 Use Race Results for Lineup 
 

If this box is checked the caution lineup will arrange competitors based on their last race position.   If the 
box is unchecked, the lineup is created based on the order the cars crossed the start/finish.  Typically this 
box is left unchecked. 

Note: Use this if you want to put lapped vehicles behind vehicles on the lead lap. 

 

2.1.6.5 Update Scoreboard on Scored Caution 
 

If this box is checked the scoreboard will continue to receive updates during a scored caution. 

2.1.6.6 Show Laptime and Speed on Caution 
 

If this box is checked the laptimes and speed will be shown for caution laps. 

 

2.1.7 Count First Crossing at Start 
 

If this box is checked the first crossing will be counted as a lap.  This is often used when the start is different 
than the finish/scoring line such as in motocross racing.  If the box is not checked the first crossing will not 
be counted, but the second crossing will be counted as the completion of the first lap.    
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Count First Crossing at Start is checked 

 

 
Count First Crossing at Start is unchecked 

First crossing is 
counted 

First crossing 
is not counted 
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2.1.8 Count First Crossing on Return to Green 
 

If this box is checked the very first crossing after returning from either a caution or restart to green condition 
will be counted.  In this case the start (green flag) button is pressed after all the vehicles have gone by the 
start/finish and the flag person has thrown the green flag.   

If this box is not checked the very first crossing is not scored after returning to green condition.  In this case 
the start (green flag) button is pressed as the flag person throws the green flag and before the vehicles have 
crossed the start/finish. 

 

2.1.9 Score Red Flag Laps 
 
If this box is checked when clicking red flag button the laps will count instead of not being scored in a 
typical red flag circumstance. 
 

2.1.10 Auto Delete Partial Laps for Red Flag 
 

If this box is checked when partial laps will be marked as red when pressing the Red Flag button on the 
timing screen. For instance, if there are 10 competitors on the track and two vehicles cross the start/finish 
line before the red flag is thrown, the crossings by the first two vehicles will be automatically marked as red. 

 

2.1.11 Auto Finish 
 

If this box is checked the software will automatically activate the Finish Flag button when the specified 
number of laps is reached.  The number of laps for a race is specified for each assignment on the Assign 
Tab.  See section 2.2.5. 

 

2.1.12 Last Lap Indicator 
 

If this box is checked, the software will show the last lap indicator when the lap count is 1 lap from the total 
number of laps specified.  The number of laps for a race is specified for each assignment on the Assign Tab. 
See section 2.2.5. 
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2.1.13 Scoreboard Control 
 

This section contains the controls to set up the scoreboard.  To use the scoreboard to display data you must 
first properly connect the computer to the scoreboard controller.  The PC must have a second available 
RS232 serial port or a USB to serial adapter to use the scoreboard.  Be sure to have the PC and scoreboard 
controller connected before enabling the scoreboard output. 

 

2.1.13.1 Set Comm Port 
 

This is used to select the port that will output data to the scoreboard.   

Click on the Set Comm Port button.  A window with a list of ports will appear. 

Select the appropriate port and click OK. 

 

2.1.13.2 Total Positions 
 

This control is used to set the number of positions on the scoreboard.  Be sure to select the proper number 
for the scoreboard being used. This limits the amount of data sent from the software to the scoreboard.  If the 
software is set for more positions than the scoreboard supports both the software and scoreboard must 
process extra data.  Some scoreboards may also exhibit unpredictable behavior.  To set the number of 
positions use the up and down arrow buttons next to the control to increment or decrement the number. 

 

2.1.13.3 Scoreboard Type 
 

Use the scoreboard type list box to select the type of scoreboard that will be used.   

Daktronics: This is for Daktronics scoreboards operating with the All Sport 5000 series controller.  In order 
to use this option, there are certain settings that must be made to the All Sport controller.  First the console 
must be placed in proper configuration by using the code corresponding to transponder usage and the proper 
scoreboard.  Second, place the console in race mode (not qualify) and press either ‘Display Time’ or 
‘Display Laps’ button. 

Generic: This is for scoreboards that are programmed to work with the generic scoreboard protocol provided 
by Race Manager.  Both All American scoreboards from Everbrite as well as TSI Timers scoreboards can be 
configured for operation with Race Manager.  Note that a separate hardware or software update may be 
necessary from the scoreboard manufacturer.  Please contact the appropriate manufacturer for additional 
information. 

Race America and Westhold selections will work with those respective scoreboards. 
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2.1.13.4 Enable Scoreboard Output 
 

Before the Race Manager software outputs data to the scoreboard, this checkbox must be checked.   

2.1.14 Network IP Addresses 
 
Lists all network interfaces available on the computer and can be helpful for determining if it is possible to 
connect to the IDEC decoder on one of the interfaces or if a modification is necessary to one of the 
interfaces in order to connect to the IDEC. 
 

 
 

2.1.15 RMViewer 
 

This feature is used in conjunction with the Westhold RMViewer, a software application used by announcers 
and other personnel monitoring the race from a networked computer. 

 
The IP Address shown in the window is the address of the computer the Race Manager software resides on.  
Note that if a computer has multiple network adapters (e.g. wired or wireless) that are enabled, Race 
Manager will select the first one on the list.  The list order can be changed in Windows 7 and earlier 
versions by going to the Change Adapter Settings screen, clicking the Alt key and then selecting the file 
menu Advanced->Advanced Settings 

 
 

The following window will appear.  Highlight the network adapter you would like to be the first adapter and 
use the arrow keys on the right to move the selection to the top.  When Race Manager is restarted the adapter 
IP address will appear in the IP Address window. 
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2.1.15.1 Set Parameters 
 

This is used to set the IP port that the information service will broadcast over.  The default is 6000. 

 

2.1.15.2 Enable Server 
 

To enable the RMViewer broadcast this checkbox must be selected.  If this is not enabled the RMViewer 
software will be unable to connect to the service and obtain race information. 

 

2.1.16 RMonitor 
 

This section contains the controls for outputting an RMonitor protocol stream.  This stream is used by many 
applications and hardware, including some scoreboards.   
 
NOTE: Some scoreboards will use the RMonitor feed.  In this case it is not necessary to set up the 
Scoreboard Control section. 
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2.1.16.1 Set TCP/IP Port 
 
This is used to set the IP port that the RMonitor information will be broadcast over. 
 

2.1.16.2 Enable Network 
 

To enable the RMonitor information broadcast server this checkbox must be selected.  If this is not enabled 
devices expecting a data stream will be unable to connect to the service and obtain race information. 

 

2.1.16.3 Set Comm Port 
 

This is used to select the serial port to output the RMonitor data on.   

Click on the Set Comm Port button.  A window with a list of ports will appear. 

Select the appropriate port and click OK. 

 
 

2.1.16.4 Enable Serial 
 

To enable the serial port to transmit RMonitor data this checkbox must be selected.  If this is not enabled 
devices expecting a data stream will be unable to obtain the data feed. 
 

2.1.16.5 Use Unique ID for Registration Field 
 
If checked the RMonitor feed will use the transponder ID in the Registration field.  This allows racers with 
the same number to be used in the same sessions.  For example, there can be two cars with 5X.  If this is not 
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checked there will be way to distinguish which car is which. 
 
Be aware that some devices use non-standard implementations of the RMonitor data feed so may not 
properly handle the unique ID capability described in the next section. 
 

2.1.16.6 Output Non-standard Messages 
 

If checked the RMonitor feed will output some non-standard RMonitor messages.  Messages include.  
‘P-Start’ and ‘Stop’ in the $F field. 

 

2.1.16.7 Digits of Precision 
 

Use this to specify the digits of precision for time output (e.g. laptime, total time) 
 

2.1.17 Sound On 
 

Check this box to enable the PC to output a beep each time a crossing is detected during a race.  This is a 
useful feature to help determine if a transponder was detected. 
 

2.1.18 Count Up Timer 
 

Check this box to enable the scoreboard output to show lap time counting up.  This is only shown for lap 1.  
 

2.1.19 Organization Name 
 

Enter your organization name (e.g. Westhold Raceway) that will be placed on printouts, the RMonitor data 
output and exported data. 

 

2.1.20 Default Track Length 
 

Click on the Default Track Length button to bring up a window that allows the entry of the default track 
length.  This is used to set the default track length when creating a new transponder assignment template.   

 
 

Click on the Use Metric Units checkbox to change the type of units to use for the speed calculation. 

 

NOTE: You must set this to a non-zero number in order to see the average lap speed displayed on the 
timing screen. 
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2.1.21 Web Data 
 

This section describes how it is possible to generate data for live internet feeds to the World Wide Web or 
for a local in-the-pits data feed that racers or fans may view.  Many Microsoft based PCs have a web server 
built in.  It is possible to configure a PC to feed race data information which can be broadcast over a wired 
or wireless network to racers or fans.  Data can then be viewed with a PC, mobile phone or other devices 
that can connect to the network and have a web browser. 
 
The server PC can be the computer running Race Manager or it can be a different computer on the local 
network.  It can even be a computer hooked up to the internet.   
 
When Race Manager is timing a race and the web data section is enabled, Race Manager will output a file 
called ‘racedata.xml’ file every 1 second.  This file contains information about the race including the race 
order and lap time information.  This file can be used with the additional data files Race Manager generates 
as described below or can be parsed and used in a custom setting. 
 
Race Manager also has a file transfer protocol (FTP) feature which allows for the upload of the racedata.xml 
data to a webserver without the need for an external program to transfer the data. 

 
 

2.1.21.1 Set Data Path 
 

Click on the folder icon to set the directory where you would like the race data file to be output.  If Race 
Manager determines the folder does not contain the default web pages, and associated files needed to display 
in-the-pits information it will ask if it should create those files.   The files include HTML, PHP and Java Script 
files.  You must have your web server configured properly to serve up this data.   

Race Manager 
PC 

Data Server – This can 
be the same as the Race 

Manager PC 

PCs, PDAs or Cell Phones in 
the Pit Area or other parts of 
the facility 

Internet - 
WWW 

Computers on Internet 
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It is not necessary to have these files if your IT person will not be using them.  Instead your IT person can use 
the ‘racedata.xml’ file and create custom web pages and data feeds.  For an example of usage visit the 
‘LiveTiming’ section of the www.westholdtiming.com website.   
 

 
 

2.1.21.2 Enable Live Web Data 
 

Check this box to enable the output of the ‘racedata.xml’ data file to the specified directory. 
 

2.1.21.3 Include Times 
 

Check this box to include lap times in the racedata.xml file.  The racedata.xml file that Race Manager 
generates does not process lap times.  However, a custom web interface can be made to display this 
information. 
 

2.1.21.4 Digits of Precision for Times 
 

You may select the total digits of precision times for the racedata.xml file.  Default is 3 digits. 
 

2.1.22 FTP 
 

Race Manager has a built-in FTP function for uploading the information in racedata.xml file described in the 
previous section directly to a server rather than producing the racedata.xml file described in the previous 
section. 

 

2.1.22.1 Enable FTP 
 

Check this box to enable the FTP data connection.  You must first set up the FTP parameters described in 
the next section. 
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2.1.22.2 FTP Settings 
 

Click the FTP Settings button to bring up the window where FTP information can be entered.   
 

 
 

Note that you only need to enter either the Server Name or the Server IP Address.  It is not necessary to 
enter both pieces of information.  Once that information and the Username and Password are entered click 
the Connect to Server button.  Once this is done the FTP path location may be selected. 
 
Enter how frequently the racedata.xml information will be written to the server in the Update Interval field. 
 
Click the OK button when finished selecting the server directory where the racedata.xml file will be saved. 
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NOTE: To change these settings while a race is occurring you must uncheck the Enable FTP 
checkbox.  You do not have to reenter every piece of information or connect to the server to do this if 
you want to simply change the Update Interval. 
 
 

 
 

 

2.2 Assign Tab 
 

The Assign page is used to create a mapping between transponder serial number identifications and vehicle 
numbers and participant names.  

The indicator will 
blink when data is 
sent to the server 

Click the Reset 
Stats button to reset 

the FTP 
information 
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Transponders 

 
Assign Tab 

 

Enter the transponder serial number (Trns ID) and the racer number (Race No.) the transponder is assigned to.  This 
is the minimum data needed to score a race.  The Misc column can be any data desired.  This can be useful for 
classifying different types of racers.  

It is possible to assign two transponders per racer.  The second transponder would be entered in the Backup Trns ID 
column.  Backup transponders are rarely used, but in cases where the race data is critical such as for television broadcast 
it can be useful.  See section 2.1.4 for additional information on backup transponder usage. 

Serial number 

Columns are sort able.  Click on a 
column header to sort ascending or 

descending. 
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2.2.1 Assignment Template List 
 

A list of available assignment templates is shown in the box at the top of the screen.  Each template has a set 
of mappings between transponder ID and car numbers.  A template may be selected at any time, even during 
a race.   

NOTE: Be careful when selecting a template during a race as this will change what is displayed on the 
Timing screen as well as on the scoreboard. 

The assignment template can be viewed as a class or even a heat assignment.  Usage will vary depending on 
the user and how they choose to organize the assignment templates. 

 

2.2.2 Add New 
 

This is used to create a new assignment template. Click on the Add New button and a window will pop up 
asking for an assignment name.  Type in a name and click OK when done.  Click Cancel to abort. 

 

 

2.2.3 Delete 
 

This button is used to delete an assignment template.  To delete a template, click on the template to from the 
list and click the Delete button.  This will permanently delete the assignment template and all the assignment 
information. 

 

2.2.4 On Track Assign 
 

The On Track Assign window is used to create the mapping between the transponder ID and the vehicle 
number.   

Select the assignment template from the list of assignment templates.   

Now enter new data or modify existing data from the template.  First enter the transponder serial number 
which is four numbers.  This is found on the outside of the transponder.  Then enter the vehicle number and 
other relevant information.  It is not necessary to enter driver names, but it can be helpful when generating 
reports later on. 

To create a new entry simply hit the Enter key on the PC keyboard and a new line will appear.   

To delete an entry, simply highlight the data to delete and hit the Delete key on the PC keyboard. 
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2.2.5 Number of Laps 
 

The total number of laps may be entered in the edit box.  When the total number of laps is reached during a 
race, the race is automatically finished as if the “Finish” button on the timing page were pressed.  This gives 
every competitor one more valid crossing.     

Note that if this feature is being used the number entered should always be verified prior to a timing session 
since the number of laps for heat races are often different than that used for the feature race. 

 

2.2.6 Track Length 
 

The track length is the length of the track in miles or kilometers depending on the default mile/km setting 
found on the Setup page.  When a new assignment template is created, the default track length from the 
Setup page is entered for the new template. 

Note: Make sure both track lengths match so that speeds will appear on Timing Screen. 

 

2.2.7 Breakout (Seconds) 
 

The breakout entry is used with the Qualify Time column in the assignment template.  If a qualify time is 
entered Race Manager will indicate when the racer lap time is equivalent to or faster than the breakout time 
interval.  For instance, if the qualifying time for a racer is 16.250 seconds and the breakout is set to 0.250 
seconds the breakout indicator will appear. 
 
The breakout is indicated by an orange highlight on the Timing page. 
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2.2.8 Race Duration (Minutes) 
 

You may enter the total amount of time you would like the race to run for in minutes.  If the checkbox for 
Auto Finish on the Setup page is checked, the race will automatically finish as if the "Finish" flag were 
pressed. 
 
Note that if this feature is being used the number entered should always be verified prior to a timing session 
since the duration may be different for different race sessions. 

 

. 

2.2.9 Use Qualify 
 
You may enter the qualify time used with the breakout feature one at a time by hand.  Or you may open up 
results with qualifying time and press the Use Qualify button.  This will automatically populate the Qualify 
Time field.  
 

2.2.10 Print Line-Up 
 

This prints the assignment template currently open.  Click on the Print Line-up to print a copy of what is 
currently displayed on the On-Track assignment screen. 

2.3 Timing Tab 
 

This page is used during timing and scoring operations.  The current running order or qualifying order is 
displayed on the left-hand side window and the crossings are displayed on the right-hand side.  

 

Time remaining is indicated here 
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Left Side Columns in Race View: 

Place – Running order 

No. – Racer number 

Name – Name of racer 

Trns ID – Transponder number 

Laps – Laps completed 

Lag – Time from leader 

Scored Time – Total time for all laps scored under green flag 

Total Time – Elapsed time from very first transponder crossing of session. 

 

Right Side Columns in Race and Qualify View: 

Index – Crossing number 

Name – Name of racer 

Trns ID – Transponder number 

Lap – Lap crossing occurred 

Laptime – Laptime of lap 

Speed – Average speed for the lap (Nonzero if track length has been entered) 

Hits/Power – Hits = number of transmissions seen as transponder passes. Power = strength of transponder 
signal. 



 

  Page 28 
 

Misc – Displays Misc field for the entry in the assignment.  Can be whatever the user enters. 

 
 

Left Side Columns in Qualify View: 

Place – Running order 

No. – Racer number 

Name – Name of racer 

Trns ID – Transponder number 

Laps – Laps completed 

Fast Lap – Lap when fastest laptime occurred 

Fast Time – Time of fastest lap 

Last Time – Laptime of most recent lap 

 

2.3.1 Lap Display Box 
 

This displays the current lap if the Down checkbox is unchecked.  If the Down checkbox is checked the 
display shows the number of laps left in the race.  If the scoreboard is enabled, the lap count will also be 
reflected in the scoreboard output. 

Note: A number other than 0 must be entered for the session on the Assign Tab screen if you want to count 
downwards.  Otherwise, the display will count upwards. 
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2.3.2 Down Checkbox 
 

If this checkbox is checked and the number of laps entered on the Assign Tab screen is greater than 0 then 
the lap display will indicate the number of laps left in the race.  If this checkbox is unchecked the lap 
indicator will indicate the current lap. 

Once the countdown reaches 0, the counter will stop at 0 even if more laps are run. 

2.3.3 RMon – Practice 
 
This is used in conjunction with the RMonitor feed.  If the checkbox is NOT checked, the transmitted 
session name will include the word ‘Race’ in it.  Otherwise, it will not.  This is useful for software or 
devices which use this feed to indicate whether the session is a practice session or a race session. 
 

2.3.4 Qualify/Place View Button 
 

This button toggles the Place/Qualify window between a running order (or place) display and the qualify 
display.  In the Place display the current running order is shown with the leader at the top.  The Qualify view 
will display the current qualifying order sorted by fastest lap.   

NOTE: This view may be changed during a race or qualifying session.  However, the scoreboard 
display will also change so caution must be used when selecting the view. 

Each column’s contents are described by the header at the top of the column.  The Tx ID column also 
displays additional information besides the transponder ID number.  If the battery of the transponder is low 
(1 day or less battery life) the word “Batt” will appear next to the transponder ID. 

2.3.5 Scoreboard Button 
 

The scoreboard button opens a scoreboard control dialog.  The ‘G’ button informs the scoreboard to turn on 
its green light.  The ‘Y’ button turns on the yellow light and the ‘R’ button the red light.  The ‘Clear’ button 
will send a reset command to the scoreboard which will either blank the scoreboard or put all zeroes into the 
scoreboard positions.  Note that not all scoreboards will respond to all the buttons. 

 
 

2.3.6 Elapsed Total 
 

The elapsed total display shows the total time that has elapsed since the Start button was pressed.  The time 
is displayed in hours:minutes:seconds format.  When the Finish button is pressed the time stops updating.  
This feature is useful for noting if a race is going beyond its allotted time frame.  The information is saved 
along with the race information. 
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2.3.7 Elapsed Green 
 

The elapsed green display shows the total time that has elapsed under Green flag conditions. The time is 
displayed in hours:minutes:seconds format. When the Yellow, Red, or Finish button is pressed the time 
stops updating. This feature is useful for noting the time it has taken to run the race under race conditions. 

2.3.8 Time Remaining 
 

The time remaining display shows the amount of time left for the race timer.  The total time is entered on the 
Assign page for each assignment.  For example, if a time of 5 minutes were entered, the timer would be 
shown counting down to 0.  When it reaches 0, the timer will turn red. 
 

2.3.9 Refresh Network 
 

Clicking this button causes Race Manager to send information via the Network broadcast and RMonitor data 
feeds.  This is useful for forcing an update when something has changed. 

2.3.10 Scroll Lock 
 

When new crossings occur the crossings grid will scroll.  Click on the Scroll Lock button to toggle this 
feature on and off.  

This is helpful when wanting to go back and check on a lap or vehicle that might have lost a lap and would 
like to find it. 

2.3.11 Session Name 
 
When an Assignment is selected from the Assign tab the name of the assignment will appear in the Session 
Name window. 
 

 
 

2.3.12 ID Check 
 
Click the ID Check button to bring up a window to check which racer with transponder is on the track.  This 
is useful for determining if a racer has forgotten their transponder or if a transponder is not operating or if a 
racer has not shown up on the track. 
 
The list on the right side of the window shows the racers and transponders in the assignment.  As racers are 
detected the racer/transponder are moved to the list on the right. 
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2.3.13 Place/Qualify Window 
 

The Place/Qualify Window on the left side of the screen is used to display the current running or qualifying 
order.  

 

2.3.13.1 Notes 
 

When the window is displaying the place view the right mouse button may be clicked, and a pop-up window 
will display and allow the software user to adjust laps up or down for a vehicle and make notes.  To do this a 
vehicle must first be highlighted.  Use the mouse cursor to click on the desired line in the window and select 
the vehicle.  Then right mouse click and click on the Notes selection to bring up the lap adjustment window 
as show in the figure below. 
 

 
Place/Qualify Window 

 

 Add notes 

Adjust laps up or 
down 
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Notes 

Clicking the up and down arrows of the Adjust (+/-) entry will increase or decrease the number of laps for a 
car.   

Note: This adjustment is only a rough adjustment.  It cannot be used to place a vehicle in exactly the 
correct spot.  Be very careful when using this feature.   

When used it may cause a vehicle to appear in the incorrect spot.  Upon the next crossing of the vehicle over 
the start/finish the vehicle will get an actual crossing time and be sorted in the correct order.  To more 
accurately add a lap, use the Insert Manual Crossing feature described in section 2.3.21.2. 

The text box may be used to add notes that may be referenced later. 

 

2.3.13.2 Assign 
 

To make changes to the car number or assignments right mouse click on the line that will be changed.  
Select the Assign selection and a dialog box will pop up to allow you to make changes or assignments. 

 
Assign 

Make the changes and press the OK button.  Pressing the Cancel button will cancel any changes made.   

Note: Any changes made here will not be reflected on the assignment template.   

2.3.13.3 Double Click 
 

Double click on one of the racers in the Place/Qualify window will manually insert a crossing to the end of 
the crossing list.  This is useful if a racer should be credited for a lap but went through the in-field and 
missed the detection loop or went into the pits. 

 

2.3.14 Crossing Window 
 

The Crossing Window is used to display all crossings. There are three tab selections for this window-ALL, 
Single and Results.  By selecting ALL, every crossing by every vehicle will be displayed.  By selecting Single 
the crossings of a single vehicle selected on the Place Window will be displayed.  To do this click and select 
the desired line from the Place/Qualify Window.  See section 2.3.22 for information on the results tab 



 

  Page 33 
 

 
 All Tab 

There are several columns in the Crossings window.  Most are self-evident.  The Hits/Power column has very 
useful data.  This data can help trouble-shoot your setup.  It can help determine if a transponder is mounted 
poorly or if there is possible external interference to the system. 

Each transponder transmits its serial number over and over again very rapidly on a periodic basis.  The Hits 
number indicates how many times the system “saw” the serial number being transmitted as it passes by the 
start/finish line detection point.  The faster the vehicle crosses the detection point, the lower the Hits number 
will be. 

The Power number is a measure of the transponder’s signal strength.  Strength numbers below mid 30s indicate 
possible problems either with the transponder location or poor cable connections in the antenna loop or coax 
cable. 

Hints 

1. As each vehicle crosses the start/finish verify that the power numbers are consistent and above high 30’s.   

2. If a transponder has numbers on average lower than the rest by about 10 then that indicates the transponder 
is not mounted in the same way as the other cars.  If the Power number is low, then the transponder should be 
relocated to a better position. 

3.  If the Power number is in the good range (about 40 and above), but the Hits number is low compared to 
other cars, this indicates poor mounting position.  This means that the transponder is not being “seen” very 
well. It could be that the transponder is in a recessed location surrounded by metal or facing the wrong direction 
(Label side of transponder should fact the antenna loop) 
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4. If the Power number is good, but the Hits number is erratic at a given speed this indicates either poor 
mounting or interference.   

5. Low power number on all vehicles indicates poor connectivity in the wiring or poor mounting on all 
vehicles. 

 

 
Single Tab 

2.3.15 Unassigned Transponder 
 

When transponders are not assigned to a competitor under the Assign tab the transponder number will show 
up in RED under the crossing screen. At any point during the race the transponder may be assigned to a 
competitor under the Assign tab or by right mouse clicking the transponder on the Place/Qualify window 
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Note: DO NOT set any unused transponders within 20 Feet from scoring loop (cable in ground of track, and 
cable running from tower to track), or any computer equipment (Computer and decoder).   These can be picked 
up inadvertently. 

2.3.16 Continue Button 
 

This button is used to continue a race or timing session which has already been stopped.  For example, if an 
event may have more than one qualifying session for the same class.  After the first qualifying session is run, 
it may be reopened again and continued by clicking the Continue button. 
 

2.3.17 Pre-Start Button 
 

This button is used to pre-start a timing session.  The crossings are recorded and shown on the crossing 
window, but not scored.  This is useful for verifying that each vehicle has a transponder and that it is 
functional properly.  Pre-start crossings are highlighted in blue.  See figure below.    

Note:  Highly recommended to use on pace laps before start of race. 

Unassigned 
transponder 
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Pre-Start crossings in blue 

 

2.3.18 Start Button 
 

To begin a timing session, click on the Start button.  It is not necessary to select an assignment template 
from the Assign page.  If no assignment template is selected or a blank one is selected the display will only 
indicate the transponder ID numbers.  Although it is possible to change a template selection during a session, 
it is NOT recommended, as this will change the output to the Timing page and the scoreboard.   

 

2.3.19 Caution Button (For non-scoring cautions) 
 

If a caution occurs this button may be pressed, and a caution condition will be enabled.  This causes the 
crossings on the Crossing Window to display the affected crossings in bronze if it is in the All view.  All 
crossings are highlighted and will not be scored. 

 
Caution 
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If the Auto Delete Partial Laps for Caution checkbox on the Setup page is checked a partial lap will be 
deleted and not scored. 

 
Before Caution Button 

 

 
Auto Delete Partial Lap 

Say the Caution 
button is pressed here 

Crossings are deleted (i.e. 
marked as caution and not 
scored) 
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When the Caution button is clicked a screen with the current lineup will appear showing the order the cars 
crossed the start/finish line during the last complete lap.  See section 2.3.18 for details. 

After the caution period is over click on the Start button to go back to a green condition. If the item Count 
First Crossing on Return to Green is checked on the Setup page described in section 2.1.8 the very first 
crossing over the start/finish line will be scored.  If this is the case, the computer operator should wait until 
all the vehicles have passed the start/finish when the green is thrown before clicking on the Start button.   

If the option Count First Crossing on Return to Green is not checked the operator should click on the 
Start button just as the green is thrown, but before the vehicles cross the start/finish.  The very first crossing 
will not be counted.  The subsequent crossing will then be counted as the first completed lap. 

2.3.20 Caution-Score Button 
 
The Caution-Score button is used when the caution crossings will be scored.  All crossings in this case will 
be scored unless the Finish Lap on Caution (Only for Scored Cautions) checkbox described in section 
2.1.6.1 is checked.  See the tutorial section 3.1 for a guide to split scoring. 
 
 

2.3.21 Red Flag Button 
 

If a red flag condition occurs pressing this button will cause a red flag to be enabled.  All crossings affected 
will be highlighted in red.  See section 2.3.18 for details on the lineup screen.  When the red period is over 
click on the Start button to go back to a green condition. 

Note: Leave red even if running under yellow until ready to go back green then press Start button unless 
scoring yellows then press Start button and press Caution-Score. 

2.3.22 Lineup Screen 
 

When the Caution, Caution-Score or Red Flag buttons are clicked a screen with the current lineup will 
appear showing the order the cars crossed the start/finish line during the last complete lap or it will show the 
last race position depending on whether or not the Use Race Results for Lineup checkbox on the Setup 
page is checked. 
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Lineup Window 

 

The left-hand side of the screen shows the lineup according to the scoring system.  The right-hand side is 
used to modify the scoreboard output.  Adjustments can be made on the right-hand side of the screen.  To do 
this you click on one of the entries on the right so that it is highlighted.  Then, click on one of the buttons on 
the right to either move the selected entry up or down. 

The Top button moves the entry all the way to the first-place position.  The Bottom button moves the 
participant to the very bottom of the list.  The Up and Down buttons move the entry up and down one 
position respectively. 

Once you are satisfied with the rearrangement the Update Scoreboard button may be clicked to send the 
modified arrangement to the scoreboard.  The Update Network button may be used to send the modified 
update over the RMonitor feed.  This is useful for updating devices with the lineup that use the RMonitor 
feed. 

Note 1: Modifications on the Lineup screen does not change the actual positions of the cars.  The 
modifications are for the benefit of the scoreboard display. 

Note 2: While the Lineup screen is displayed the scoreboard will not update positional changes in non-
scoring cautions conditions. 

 
 



 

  Page 40 
 

2.3.23 Finish Button 
 

Click the Finish button right before the leader takes the checkered.  This allows each competitor to be 
scored for only one more crossing.  All subsequent crossings are recorded but not scored.  This prevents the 
leaders from being accidentally scored if they do not get off the track right after crossing the start/finish line. 

When the Finish button is pressed a line with checkered flags will appear on the crossing window.  When a 
crossing occurs after this line a small, checkered flag will appear next to the racer on the Place/Qualify 
window to indicate the racer has taken the checkered.   

NOTE: This is a useful feature to determine if there are racers still left on a track. 

 
 

NOTE: If you are unable to click the Finish button before the leader crosses the start/finish then you can 
left-mouse click on the finish flag and drag the finish flag to the correct position.  You may also hit the stop 
button before the leader returns to the start/finish line.   

 

If the Finish button were accidentally pressed the race can be continued by clicking on the Start button.  
The finish flag line will disappear, and the deleted crossings will be turned into green flag crossings. 
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2.3.24 Stop Button 
 

Click the Stop button to stop all scoring.  When this is done a window will pop up and the user is given a 
chance to save the results of the timing session.  The default file name is the name of the assignment 
template used.  You can change this by typing the name of the file to save the data as and click OK.  If 
Cancel is clicked, no data is saved.  However, it is still possible to save the data by going to the menu item 
<FILE>\<SAVE RESULTS>. 

NOTE: A very useful feature is the auto save feature.  When the Stop button is pressed Race Manager 
automatically saves the race data in a folder called ‘AutoSave’.  This folder is located in the directory that 
Race Manager is located in. 

Attention: For Windows Vista machines and higher this may not be the case.  If your PC is configured for 
multiple users (i.e. User Control ON - default for Vista PCs) and Race Manager is installed under 
C:\ProgramFiles (x86) your data will be stored in a virtual directory under your main C drive.  This is 
usually the directory  C:\Users\AppData\Local\VirtualStore\Program Files\RaceManager.  The auto saved 
races are named with the assignment name first followed by a date/time stamp.   

2.3.25 Crossing Window Pop-Up Menu (Used to modify crossing status) 
 

This menu can be used to change any crossing to a different flag condition.  For instance, it can be used to 
change a green flag crossing to a caution flag crossing or a red crossing.  There are also several other options 
for inserting manual crossings.  See the sections below for a more detailed description. 
 

2.3.25.1 Changing Crossing Type 
 

Individual or multiple crossings may be selected for, and their crossing type changed by first highlighting 
the desired crossing and then right-clicking the mouse with the mouse cursor in the Crossing window.  
Select the desired choice such as Set Caution and the crossing type will change.  This is a very useful 
feature used to correct mistakes such as accidentally pressing the Caution button at the wrong time. 
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Crossing window right clicked 
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Highlighted Crossing Changed 

Note: Be careful using this feature.  It is a powerful feature but can have unintended consequences. 

 

There is a special crossing type called Force Count.  Depending on the selections made in the Setup page 
sometimes a crossing may not be counted.  For example, after returning to green from a caution the first 
crossing is not counted if the Count First Crossing on Return to Green checkbox is not checked.  If the 
competitor has gone to the pits and upon their return the crossing must be counted, then select the Force Count 
selection.  See the figure below. 

 

Highlighted crossing 
is changed 
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Use Force Count 

 

 
Crossing is now counted. 

 

 

Say this competitor went into 
the pits.  Upon returning to the 
track it is not counted since we 
just returned to green. 
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2.3.25.2 Insert Manual Crossing 
 
There are two ways to add a manual crossing.  The first way is done by selecting a car in the Place/Qualify 
window on the left and selecting which crossing the manual lap should be inserted before on the Crossing 
window.   
 

 
Highlight Driver 

 
A car will get a manual lap inserted before the first car crosses.  Note that the manual lap is created such that 
it is exactly halfway in time between the crossing immediately before and immediately after the point it is 
inserted.  Manual laps are useful if a car misses the antenna loop by perhaps driving through the infield area.  
 

 
Inserted Manual Crossing 

Say we want to insert a 
crossing here 

Manual crossing 
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This first method requires that a transponder already has any entry on the left-hand Place window.  The 
second method does not require this.  There are 2 ways to do this.  For the first method left double click on 
the line on the Crossing window that the manual crossing will be entered at.  The Manual Racer Quick 
Add window will pop up. 
 

 
Manual Quick Add Window 

 
Now either select the racer to add a crossing for and click the OK button or double click on the racer.  This 
will add a new manual crossing. 
 
The second way to bring up this window is to click on the crossing on the crossing screen where you want the 
manual crossing to be entered.  Then right mouse click to bring up the pop-up menu.  Now select the Add 
Driver option.  The Manual Quick Add window will appear. 
 

 
 

Select Add Driver 
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2.3.25.3 Delete Crossing 
 
A crossing may be deleted by highlighting a crossing, right mouse click over the Crossing window and 
selecting Delete Crossing from the pop-up menu.  Manual crossings will be permanently deleted.  
Electronic crossings will be grayed out and not counted towards scoring.   
 

 
 

 

2.3.25.4 Insert Lap 
 

To add a lap to the entire field highlight the line where the lap should be inserted, right mouse click over the 
Crossing window and select Insert Lap from the pop-up menu.   
 

 

Electronic crossing 
deleted – still saved, 
but not counted. 
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2.3.25.5 Delete Lap 
 

A manually inserted lap may be deleted by highlighting the manual lap (ie Lap+1) and selecting Delete Lap 
from the pop-up menu.  
 

 

Note all crossings after the 
inserted lap are bumped up 
by 1 lap. 



 

  Page 49 
 

2.3.26 Results Tab 
 
When the Stop Button is pressed and a timing session is concluded, the Results tab on the Crossing 
window becomes enabled.  Clicking on the tab shows the final results view of the session.   
 

 
 

Results Tab 
 

 
 

Results Screen  
 
The results may be manipulated using the buttons on the right-hand side of the screen.  Highlight the competitor to 
modify and click on one of the buttons on the right-hand side to move the competitor.   
 
The Refresh Network button is used to send the modified results to applications that use the network broadcast or 

Results tab 
enabled 
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RMonitor feed. 
 
Note: After manipulating the results, the data must be saved.  Do this by selecting the menu item  
<File>/<Save Results> or <File>/<Save Results As>. 
 
If the Misc column were used in the assignment template, you can sort the finish according to the Misc column 
information.  Note in the figure below that the finish order is sorted according to the Misc column as opposed to 
showing the overall order. 
 

 
 

2.3.27 Print Buttons 
 

There are two print buttons.  One button will print what is in the Place/Qualify window; the other button 
will print all crossings found in the Crossing window.  The functionality of the left print button will print 
the appropriate information depending on whether the software is in qualifying or place mode as defined by 
the Qualify/Place View button.   Note that the button will change text to indicate what will be printed. 



 

  Page 51 
 

 
 

2.3.27.1 Print Dialog 
 

When one of the print buttons is pressed a window will pop up.  Depending on which print button is pressed 
the window may look slightly different.   
 

 OR  
 
There are 2 print formats to choose from.  One is the Standard format, and the other is the Grid format. The 
standard format allows for the addition of notes and a logo.  The Grid Format prints what is shown on the 
Race Manager grids.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Button changes text 
depending on view 
mode selected 
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Grid Format 
This format is printed in a “what you see is what you get” format and prints what is shown on the timing 
page.  You may have to adjust the columns in order to fit the page size selected.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.27.2 Print Notes 
Allows for the insertion of notes in the Standard format report.  When producing Grid format reports the 
notes will not be printed.   
 

 
 

2.3.27.3 Print Image 
 

It is possible to include an image such as your organization’s logo or sponsor’s logo in your printout.  Click 
on the folder icon and choose the image you want to print.  The only format Race Manager currently 
supports is the bitmap format (.bmp files).  If you have a JPEG (.jpg) or GIF (.gif) format image you can 
open this in a program such as Microsoft Paint and then ‘save as’ a bitmap file. 
 
In order to print the logo, the Print Image box must be checked. 
 
Images will auto-size to fill a 2.5 inch wide and 1.25 inch high area.  In other words, images should have an 
aspect ratio of 2:1.   
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2.3.27.4 Lap Chart Format 
 
This option is available when the All print button is pressed.  Selecting this option will create a printout in 
lap chart format. The lap chart shows the order each racer passed the start/finish line for each lap. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.27.5 Race Order Format 
Use this option to create a printout showing the racer position for each lap.  This report is similar in 
appearance to the lap chart but shows the running position for each racer at each lap. 
 

  
 
 

Lap 

Racers 
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2.3.28 Menu Items 
 

 
 
 

2.3.28.1 File->Open Results Menu Item 
 

Select the File->Open Results menu item to open previously saved results and display them on the screen.  
Open results may be adjusted using the Adjust Laps and the Set Green/Set Caution, etc features described 
above on the crossing screen only.  The results may then be re-saved.   

 

2.3.28.2 File->Merge Results Menu Item 
 

Select the File->Merge Results menu item to combine another set of results to currently open results.  This 
feature is useful when there is more than one qualifying session for a class.   
 

2.3.28.3 File->Close Menu Item 
 

This clears the data from the screen and from memory. 
 

2.3.28.4 File->Save Results Menu Item 
 

This will save the results on the screen. 

 

2.3.28.5 File->Save Results As Menu Item 
 

This will save the currently open race results on the screen to a new file. 

 

2.3.28.6 File->Recover 
 

This item allows for the recovery of data from the system.  If for instance your PC crashes or someone exits 
the Race Manager program before the Stop button was pressed you can recover the race data.  Normally 
when Race Manager is restarted it will detect that the software was closed prematurely and will ask whether 
the user wants to recover the race. 
 
In some circumstances the user may have accidentally pressed the Stop button before the race finished.   By 
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selecting the File->Recover menu item it is possible to recover the data.   
 
 
 

 
 
Check the Clear Race Data checkbox if you wish to clear what is currently on the timing page.  Otherwise, 
the data will be added to what is already in Race Manager memory. 
 
NOTE: This will not work for IDU systems.  On IDU systems once the Stop button is pressed the data in 
the IDU will be deleted.  However, some of the recovery data may still be on the PC hard drive and that data 
may be recovered.   

 

2.3.28.7 Upload Menu Items 
 

There are 3 menu items used for uploading data to the westholdtiming.com server. These are the Clear 
Upload Directory, Upload Results and Upload Settings described below.  The data uploaded to the 
westholdtiming.com server may be incorporated into your own website using an iFrame.   
 

 
 

2.3.28.7.1 File->Clear Upload Directory 
 

This deletes all files in a directory called UploadXML.  This directory is created by Race Manager to hold 
data for uploading.  The files in this directory are generated whenever you start, stop and save the race data.  
You should clear this directory before each event or there may be many unnecessary files in the directory. 
 
Note: If you do not save the timing session results an upload file will not be saved for that session. 

 

Enter number of crossings to 
recover 
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2.3.28.7.2 File->Upload Results 
 

To upload results to the westholdtiming.com server select this menu item.  The window shown below will 
appear.  This window is used to manage the events and races on the server.  The left side shows the events 
on the server.  The right side shows the races under each event. 
 

 
 
 
Click the New button to add a new event.  Select the day of the event and type in a name.  Then click the 
OK button when finished. 

 

 



 

  Page 57 
 

 
 
Select the event to add races to and click the Add Race(s) button.  A window will appear to allow you to select races 
to add.  

 
 

You can then select which races to upload by checking the box next to each race or use the Select All  button to select 
all of the races.  Click the OK button when finished.   
 
If there are no races in the UploadXML directory you may generate these files by clicking the folder icon in the upper 
right. 
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A window will open as shown below.  Use this to navigate to the location of your results files.  Click the OK button 
and the upload files will be generated.  Then you can select and upload the desired races to the server. 
 

 
 
 

 
 
 
You may delete an event by selecting the event to delete and clicking the Delete button. To delete specific races, 
check the checkbox next to each race to delete and then click the Delete Race(s) button.   
 

2.3.28.7.3 File->Upload Settings 
 

This is used to enter the password and username for your organization.  You must obtain this from 
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Westhold.  You may contact them via email (info@westhold.com) or phone (see Contact at 
www.westhold.com).  You only have to enter this once before using the File->Upload Results selection.  
All subsequent uploads will not require you to reenter this information. 
 

 
 

Note: If you experience problems connecting to the server you may need make sure the Windows firewall or 
your anti-virus program allows Race Manager access to the internet.  You may also have to allow port 21 to 
be open.   

 
 

2.3.28.8 File->Exit Menu Item 
 

This will exit the Race Manager program. 
 
 

2.3.28.9 Options->Font Menu Item 
 
This option is used to change the font size of the place and crossings grids’ text.  Note that the font is not 
saved when closing the program. 
 

 
 

2.3.28.10 Export Menu Item 
 

The export menu allows the race data to be exported to HTML files or comma separated ASCII text files for 
either uploading to a website or for further processing. 
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2.3.28.10.1 Export->HTML Menu Items 
 
Export->HTML->Place (Electronic Results) – Exports only the electronic place results.   
 
Export->HTML->Crossings – Single – Exports only the crossings data for a single selected competitor.   
 
Export->HTML->Final Results – Exports the modified results from the Results tab page. 
 
Export->HTML->Full Session Export – Creates a final results page with links to all the single crossings 
report for each competitor. 
 

2.3.28.10.2 Export->CSV Menu Items 
 

The CSV exports operate just like the HTML exports except comma separated CSV files are generated. 
 

2.3.28.10.3 Export->XML Menu Item 
 
The XML export operates like the HTML and CSV exports except there is only a single option.  This can be 
used to individually generate upload files for uploading to the westholdtiming.com server. 

 

2.3.28.11 Help Menu Item 
 

This option is used to identify what version of software is being used and copyright information. 
 

 
  



 

  Page 61 
 

3. Tutorials  
3.1 Split Score Guide 
 

This section describes how split scoring works.  In this tutorial we will count caution as the leader plus one or 
more competitors cross the start/finish before the caution is thrown. 

 
1. Caution Handling Setup 
 
Check the Finish Lap on Caution checkbox.  This setting allows each driver to finish the current lap when 
the caution drops. This only works with the Caution-Score button.   
 
Check the Auto Delete Partial Laps for Caution checkbox.  When the non-scoring Caution button is 
pressed, partial lap crossings are set to caution and not counted.  
 
If you want to immediately count the lap as complete when the green flag comes out and the leader crosses 
the start/finish line, check Count First Crossing on Return to Green.  
 
If the first crossing upon returning to green flag condition is the start of the lap, then DO NOT check Count 
First Crossing on Return to Green.  
 
Attn:  If the entire field has passed the start/finish and completed a lap and the caution comes out while the 
cars are on the back stretch of the track, press the Caution-Score button to count the lap.  Otherwise, pressing 
the Caution button will revert the lap to the last completed lap despite the lap having been completed.  
 

 
Fig 3.1-1 
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2. If the yellow flag is thrown after at least the leader has crossed press the Caution-Score button.  See fig 
3.1-2 

 

 
 
 
 

Fig. 3.1-2 
 

The lineup screen will pop up showing the order.  See fig 3.1-3 below.  Note how cars 99 and 36A are first 
and second and in the order they crossed before the caution.  Now cars 36B, 93 are drawn from the previous 
crossing.  And car 12 comes in at the end. 
 

 
 

At least Leader has 
crossed 

Press this 
button. 
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Fig 3.1-3 
 
 

Now as the cars cross the start finish under caution… 
 

 
 

Fig 3.1-4 
 

The lineup screen will still show what is in figure 3.1-3.  To correct the lag values you can hit the “Reset” 
button on the lineup screen.  See fig 3.1-5.  This is not necessary.  The lineup will still be correct.  The 
number of laps displayed on the scoreboard should be lap 5 since that is the leader’s current lap. 

Cars that already 
crossed are not 
counted again. 
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Fig 3.1-5 
 
 

3. In the case where it is decided that the caution will not be scored and the leader has crossed before the 
caution is thrown, hit the non-scoring Caution button. Fig 3.1-6. 

 

 
 

Fig 3.1-6 – Only leader has crossed 
 
 
 

The partial lap will automatically be deleted.  Fig 3.1-7. 
 

Press caution 
button 
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Fig 3.1-7 
 
All subsequent crossings will also not be scored. 
 
Note that if you accidentally press the “Caution” button too late and more than 1 car has gone by that is ok.  
The partial lap will still automatically be deleted. Fig 3.1-8 
 

 
Fig 3.1-8 

 
The lineup in this case is based on the previous lap completed (lap 6 – index 28).  Fig 3.1-9 below. 

Say you pressed 
caution here.  This is 
OK 
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Fig 3.1-9 
 

Note that anything can be changed by highlighting the crossings you want to change and right clicking the mouse button 
on the crossings screen.  Just select how you want to change the highlighted crossings.  You can correct mistakes you 
might have made. Fig 3.1-10. 
 

 
 

Fig 3.1-10 
 

Select what you want the 
crossings changed. to. 
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